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Introduction

Preface
The 1998-99 Quality Assurance Program for Windows software is designed to
calculate data Readings you will use as a basis for quality improvements at your
institution. The software measures three types of Readings:

• Summary Readings consist of overpayments and underpayments for Pell Grants,
overpayments for Campus-Based aid, overcertifications and overpayments for
subsidized FFELP Loans, and overawards and overpayments for subsidized
Direct Loans as well as any Pell Grants and SEOG’s overpayments for graduate
students.

• Institutional Readings consist of all types of readings on data over which an
institution has control, ranging from disbursements made in the absence of
Satisfactory Academic Progress to errors made in the calculation or disbursement
of Title IV aid. There are three subsections for institutional readings: Pell Grants,
Campus-Based Aid, and Subsidized FFELP/Direct Loans.

• Student Application Readings are made on data reported by the student or
family, such as, the reporting of income, household size, and number of persons
in college. Quality Assurance Program for Windows reports Student Application
Readings for Pell Grants and Subsidized FFELP/Direct Loans.

The software also allows you to examine subsets of your sample, which you then can
use to analyze your student population.

Using This Installation Guide
Use the instructions contained in this Installation Guide to install the software on
your computer or local area network (LAN). If you are installing the 1998-99 software
for the first time, choose the Full installation option for this release of Quality
Assurance Program for Windows.

This guide also provides you with hardware and software requirements, LAN
compatibility issues, and how to get help.
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Help
Instead of a paper user’s guide, Quality Assurance Program for Windows has online
help. General help is available from the menu bar and field help is available by
pressing the F1 key. See the topic Using Help in the online help for more information.

New for 1998-1999! Also provided with this release of Quality Assurance Program for
Windows is a desk reference that describes the various menu items, gives helpful
hints, and lists customer service information.

For questions regarding:

• technical assistance

• import/export problems

• ISIR/custom file layouts

• software functionality

call CPS Customer Service at:

800/330-5947

For all other program or policy questions, call the Department of Education at:

202/260-4788

See the topic CPS Customer Service in the online help and this Installation Guide for
more information.
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System Requirements

 Hardware and Software Requirements
The following hardware and software are required for Quality Assurance Program for
Windows:

• IBM or fully IBM-compatible PC with a 486DX2 66MHz processor or
better

• 16 MB total memory or more

• 300 MB of available hard disk space (depending on the functions you
use and how many records you store in your database)

• 3.5" high-density floppy disk drive

• Microsoft compatible mouse

• Hewlett Packard (HP) LaserJet compatible printer and printer driver

• MS-DOS version 6.2 or higher (unless using Windows 95 or Windows
NT)

• Microsoft Windows version 3.1, Microsoft Windows for Workgroups
3.11, Microsoft Windows 95, or Microsoft Windows NT 3.51 or above

§ Consider a quad-speed (or better) CD-ROM drive for software tutorials
and other future software distributions

§ Consider a tape backup system to store your data

§ Monitor and video card capable of standard VGA (800 x 600) resolution
(small fonts only). Quality Assurance Program for Windows was
designed in super VGA. You may use a higher resolution than super
VGA at your own discretion.
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Estimating Hard Disk Space
The following information gives you an estimate of how much hard disk space is
required for each ED software product and for certain types of records.

EDconnect, and NET*CONNECT are software products provided by the Title IV
WAN.

The maximum number of records that you will have on the Quality
Assurance Program for Windows database is 300. The total space
required for the software and 300 records is approximately 2 MB.

To find out the approximate total space required, add together the amounts shown for
each ED-software product and the types of records you are using. You should also
take into account other software products installed on your PC. For example, the total
space required for Quality Assurance Program for Windows (with 300 records) and
5,000 Direct Loan, ISIR, NSLDS, and Packaging records using all of the software
products listed is approximately 68 MB.

Each software product requires the following space:

Product Size

Quality Assurance Program for Windows
with 300 records

2 MB

SSCR-32 with 300 records 6 MB

EDconnect/NET*CONNECT for Windows 15 MB

EDExpress for Windows 16 MB

OPEnet 2 MB

Each set of 5,000 records requires the following space:

Record Size

Direct Loan 6 MB

ISIR 15 MB

NSLDS 4 MB

Packaging 2 MB
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Local Area Network (LAN) Server
Compatibility

LAN Server Compatibility
Quality Assurance Program for Windows can be used as stand-alone or multi-user
software. It can be run on the following network operating systems:

• Novell Netware 3.x and 4.x

• Microsoft Windows NT Server

• Microsoft LAN Manager

You should not run the software on peer-to-peer networks such as Artisoft
LANtastic, Novell’s Personal Netware, and Microsoft Windows for Workgroups.
(Note: Microsoft Windows for Workgroups 3.11 can be used as a desktop operating
system, but not as a network operating system.)

According to the Microsoft Knowledge Base, some anomalies have been known to
occur when using Microsoft Access with the following networks: DEC Pathworks,
IBM Lan Server, and Sun PC-NFS. Since Quality Assurance Program for Windows
makes extensive use of Microsoft Access as a database engine, do not use these
network operating systems with Quality Assurance Program for Windows.

LAN Cautions
When multiple users are concurrently updating databases in the Quality Assurance
Program for Windows database, those records are locked. Also, certain functions are
locked when concurrent access would degrade the system or disrupt a process.

Examples include:

• The database is locked when the executing function is mass loading
records.

• Records are locked when an executing function needs stable data for
updating or printing.

• Functions are locked when multiple executions of the functions would
destroy the databases.
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LAN Messages
These messages notify users when a locking situation occurs.

LAN Error Message

Condition

<Database> is locked and cannot be accessed at this time.

If the database remains locked after five seconds of continual attempts, the user is
returned to the menu bar or to the point prior to execution.

Record in use - Retry later.

If the record remains locked after five seconds of continual attempts, the user is
returned to the menu bar or to the point prior to execution.

Function in use - Retry later.

If the function remains locked after five seconds of continual attempts, the user is
returned to the menu bar.

Additional LAN Instructions
1. If you are running Quality Assurance Program for Windows from a Novell file

server, the NET.CFG file on all workstations should contain the following
statement:

 File Handles = 120

2. From the Netware server Console prompt, you should enter the following
commands:

 Set Maximum Record Locks Per Connection = 10000

This line should also be added to the AUTOEXEC.NCF file on the Netware
server.
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LAN Hardware and Software Recommendations
• IBM or fully IBM-compatible PC with a 486DX2 66MHz processor or

better

• 16 MB total memory or more on each workstation

• 300 MB available hard disk space on the file server (depending on the
number of records you will store in your database)

• MS-DOS version 6.2 or higher (unless using Windows 95 or Windows
NT)

• Desktop Operating System: Microsoft Windows versions 3.1 or 3.11,
Microsoft Windows for Workgroups 3.11, Microsoft Windows 95, or
Microsoft Windows NT 3.51 or above

• Network Operating System: Novell NetWare version 3.12 or higher,
Microsoft Windows NT 3.51 or above, or Microsoft LAN Manager

• 16 megabit/sec transfer rate on the network for token ring, 10
megabit/sec transfer rate on the network for Ethernet, or the maximum
transfer rate your network topology supports

• Monitor and video card capable of standard VGA (800 x 600) resolution.
Quality Assurance Program for Windows was designed in super VGA.
You may use a higher resolution than super VGA at your own
discretion.

Note: For questions regarding any of the listed hardware or
software requirements, please contact CPS Customer Service at
800/330-5947.
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Installation Instructions

Installation Process
This section of the Installation Guide provides you with step-by-step instructions for
installing Quality Assurance Program for Windows . Instructions are provided for
both network and stand-alone system installation.

Depending on the type of install you are performing (network or stand-alone), all
installation diskettes may not be required.

Other topics include:

• Install Log creation

• CONFIG.SYS and NET.CFG statements

• Uninstall instructions

• How to change your Swap File settings

Follow the prompts the software provides you when installing Quality Assurance
Program for Windows.

Directory Creation
The installation process automatically creates the directory WINQAP9 for Quality
Assurance Program for Windows files on your local hard disk.

The C: drive is assumed to be the drive letter of your local hard disk, but you can
change the drive letter if necessary. Also, you may want to use a different name for
the directory.

If you are performing a network server installation, be sure to install to a LAN drive
and not to a local drive.
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Installing Quality Assurance Program for Windows on a
Network

When you perform a workstation installation, the executable file for Quality
Assurance Program for Windows (WINQAP9.EXE) installs to a workstation’s local
hard drive.

Installing this file to the workstation’s hard drive rather than the network file server
improves the speed and performance of the software because Quality Assurance
Program for Windows uses the combined resources of the workstation and the file
server instead of those of the file server alone.

Follow the instructions below to install Quality Assurance Program for Windows on
local area networks.

Installation Instructions
1. First, use the Network Server installation option to install this version of the

software. This option installs only the QA database (WINQAP9.MDB) on the file
server, not the QA program files.

2. Then, do Full workstation installations on all workstations for this version of
the software. Choose the Network Workstation installation option, then select
Full. The Full option installs the executable file (WINQAP9.EXE) in a local hard
drive directory. It also establishes the workstation’s ODBC (open database
connectivity) connection to the QA database. The Workstation installation
option prompts you for the location of the database installed during the Network
Server installation (step 1).

If you have questions, call CPS Customer Service at 800/330-5947.

Additional Instructions
If you want to copy the installation diskettes to a file server so you can do
workstation installations from the server, follow these steps.

1. Create a disk directory for each diskette received. If you receive three diskettes,
then create three directories on the file server; if you receive five diskettes, then
create five directories on the file server; if you receive seven diskettes, then
create seven directories on the file server, etc. In the preceding five diskette
example, you would create a directory structure like this one on your server.

 \Install

 \Install\DISK1

 \Install\DISK2

 \Install\DISK3

 \Install\DISK4

 \Install\DISK5

 Note: The parent directory can have any name, but the subdirectories must be
named DISK1, DISK2, etc.
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2. Copy the contents of each disk into its corresponding directory on the server.

3. You can now install QA from the file server by running SETUP.EXE from the
DISK1 directory on the server instead of carrying the diskettes to each
workstation.

If you have questions, call CPS Customer Service at 800/330-5947.
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Installing Quality Assurance Program for Windows on a
Stand-Alone System

Be sure that all Windows applications, including screen-savers, e-mail notifiers, etc.
have been closed before you proceed with this setup. Microsoft ODBC (open
database connectivity) Setup will fail if any of these applications are still running.
You can install Quality Assurance Program for Windows using one of three options:

• Full. Use this option when you are installing Quality Assurance
Program for Windows for the first time . It overwrites all existing 1998-
1999 Quality Assurance Program database and program files (*.EXE
files).

Warning:  If you choose the Full Install option, the
program will remove/erase ALL your existing QA
database and program files (*.EXE files).  

• Upgrade . Use this option only if you have already installed a full
version of Quality Assurance Program for Windows for 1998-99. This
option updates only program files (*.EXE files) and leaves your current
databases intact.

• Custom. If you have already installed a full version of Quality
Assurance Program for Windows for this processing cycle, you can use
this option to replace executable program files, ODBC files, HELP,
and/or the QA database. This option leaves all other system settings
intact.

Note: If you have forgotten your password, to reset the QAPADMIN
user ID and password do a Custom installation selecting the Update
Database  component only. (This action will not affect your
databases.) A pop up box with the option to reset QAPADMIN will
appear. An Upgrade  installation will also give you the option to reset
QAPADMIN.

Windows 3.1 or 3.11
1. Turn on your computer and start Microsoft Windows.

2. Insert Diskette #1 in the A: drive.

3. Select File from the Windows Program Manager menu bar.

4. Select Run from the File pull-down menu.

5. Type a:setup at the command line and click OK. The software is
installed to the default directory C:\WINQAP9 unless you choose
another location.

6. Insert diskettes in numerical order and click OK when prompted.

Quality Assurance Program for Windows asks you a series of questions during the
installation. Each question has a default answer. If the default is correct, click  Next
in response to each question. If not, type the correct answer and click  Next. When it
is finished installing the files for Quality Assurance Program for Windows, the
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installation program adds a program group and icons to your Program Manager
window.

Windows 95 or Windows NT
1. Turn on your computer and start Microsoft Windows.

2. Insert Diskette #1 in the A: drive.

3. Select Start from the Task bar.

4. Select Run from the Start pop-up menu.

5. Type a:setup at the command line and click OK. The software is
installed to the default directory C:\WINQAP9 unless you choose
another location.

6. Insert diskettes in numerical order and click OK when prompted.

Quality Assurance Program for Windows asks you a series of questions during the
installation. Each question has a default answer. If the default is correct, click  Next
in response to each question. If not, type the correct answer and click  Next.

When it is finished installing the files for Quality Assurance Program for Windows,
the installation program updates your Start menu. It will not, however, create desktop
icons/shortcuts or update them if they have already been created.
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Install Log
Each time an installation is performed, an Install Log is created. The information that
will be tracked is the product and version number, type and nature of the install,
drive/directory, date, and time of install. This file is named INSTALL.LOG and is
located in your C:\WINQAP9 directory.

Example:

<APP NAME> Quality Assurance Program for Windows

<VERSION> 3.x

<TYPE> FULL: Install everything.

<SUMMARY> New release for ‘98-99 cycle

<TARGET> C:\WINQAP9

<DATE> 03-19-99

<TIME> 08-36-54

CONFIG.SYS and NET.CFG
The software can modify your CONFIG.SYS file automatically. If you do not want
Quality Assurance Program for Windows to modify this file, select the appropriate
option and click Next.

To modify your CONFIG.SYS file independently at a later time, add these statements
to the file:

Files = 120 (or greater than 120)

Buffers = 32 (or greater than 32)

If you are running Quality Assurance Program for Windows on a Novell Server, then
your NET.CFG file should contain the following statement:

File Handles = 120 (or greater than 120)

For Windows 3.1 and 3.11 Users

For Windows 3.1 or 3.11 users, Quality Assurance Program for Windows will install
the VSHARE.386 file if the file is not present. The VSHARE.386 file will be set up in
the SYSTEM.INI (386 Enhanced) file’s section.

Note:  Remember to reboot your computer when done.   
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Uninstall
After you have installed Quality Assurance Program for Windows, you will see an
Icon for the Uninstall utility. By double-clicking on Uninstall, the utility deletes all
icons, the software’s program group, all executable files, all DLLs, and the entire
database for the version of Quality Assurance Program for Windows you have
installed. If Quality Assurance Program for Windows is installed on a LAN, the
Uninstall utility will only delete the Quality Assurance Program for Windows icons.

To uninstall Quality Assurance Program for Windows:

1. Double-click on the Uninstall icon.

 A prompt asks if you are sure that you want to completely remove the
application and all of its components.

2. Click the Yes button.

3. Click OK.

Changing Your Swap File Settings
Windows 3.1 or 3.11 uses swap files to improve the way your computer uses memory
while you are in Windows, which in turn improves system performance. Swap files
can be temporary or permanent. For maximum performance from Quality Assurance
Program for Windows, your swap file setting for Windows should be set for a
permanent swap file and use 32-bit disk access (also 32-bit file access if running
Windows for Workgroups 3.11). For simplicity, users can also select a  temporary
swap file.  Before you install Quality Assurance Program for Windows, you should
review your swap file setting.

To change your swap file setting to Permanent from the Windows
Program Manager:

1. Open the Main group or the group where your Control Panel icon is
located.

2. Double-click the Control Panel icon.

3. Double-click the 386 Enhanced icon.

4. Click the Virtual Memory button. Look at Type to see if your swap file
is currently set to Permanent (using BIOS) or Temporary (using MS-
DOS).

5. If the setting is Permanent (using BIOS) and 32-bit disk access (also 32-
bit file access if using Windows for Workgroups) is checked, click OK
until you return to the Program Manager window. You are ready to
install Quality Assurance Program for Windows.

6. If the setting is  Temporary (using MS-DOS), continue with step 7.

7. Click the Change  button.

8. Click the down arrow  in the box next to Type and select Permanent.

9. Check the box next to 32-bit disk access (also check 32-bit file access if
using Windows for Workgroups).
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10. Click OK.

11. Restart Windows and proceed with installing Quality Assurance
Program for Windows.

To change your swap file setting to Temporary from the Windows
Program Manager:

1. Open the Main group or the group where your Control Panel icon is
located.

2. Double-click the Control Panel icon.

3. Double-click the 386 Enhanced icon.

4. Click the Virtual Memory button. Look at Type to see if your swap file
is currently set to Permanent (using BIOS) or Temporary (using MS-
DOS).

5. If the setting is Temporary (using MS-DOS), click OK until you return
to the Program Manager window. You are ready to install Quality
Assurance Program for Windows.

6. If the setting is  Permanent (using BIOS), continue with step 7 below.

7. Click the Change  button.

8. Click the down arrow  in the box next to Type and select Temporary.

9. Click OK.

10. Restart Windows and proceed with installing Quality Assurance
Program for Windows.
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Getting Started

Logging In for the First Time
Each time you start Quality Assurance Program for Windows, you must enter a valid
user ID and password. Quality Assurance Program for Windows requires user IDs
and passwords for system security.

The first time you use Quality Assurance Program for Windows, enter QAPADMIN
for both your user ID and password. QAPADMIN is the user ID and password
included with Quality Assurance Program for Windows. You will then be prompted to
enter a new user ID and password.

Follow these steps to log in to Quality Assurance Program for Windows for the first
time.

To log in and establish your new user ID and password:

1. The first time you use Quality Assurance Program for Windows, enter
QAPADMIN for both your user ID and password.

2. Press Enter or click OK.

 You will be prompted to enter a new User ID and Password.

3. Press Enter or click OK.

4. On the next screen, enter a New User ID, Password, and Verify password.

• Up to eight (8) alphanumeric characters may be entered.

• The Password and Verify Password must be the same.

5. Press Enter or click OK.

6. Quality Assurance Program for Windows will indicate that the updates have
been saved.

7. Press Enter or click OK.

After you enter your user ID and password, a message box displays any messages,
warnings, or errors.
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Getting Help
There are a number of ways to get help:

• Reviewing installation instructions

• Becoming familiar with your PC

• Contacting your system administrator

• Using Online Help

• Calling CPS Customer Service

These approaches are described below.

Review Installation Instructions
Review the installation instructions again. See if you perhaps left out a step. Try the
installation process again.

Become Familiar with Your PC
If you have completed the Quality Assurance Program for Windows installation, click
System Information from the Help menu.

Compare this information to the required configurations listed at the beginning of this
section. You may need to upgrade your equipment or change your files.

Contact Your System Administrator
Your institution or organization may have additional instructions for your PC. For
example, you may get an error if you are trying to install the software to a drive for
which you do not have access.

Quality Assurance Program for Windows Online
Help
Using Help is simple. You can get help by any of the following methods:

• From the Help menu, choose a Help command.

• Choose the Help button available in many dialog boxes.

• Use the keyboard to select an item on a menu, and then press F1 to see a
description of the item.

• Select a dialog box option or command, and then press F1 or click the Help
button to move directly to an explanation of the option.

• Use the Context Help Toolbar button to obtain help on menu options
and other Toolbars.
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CPS Customer Service
If you need technical support, call CPS Customer Service at:

800/330-5947

Representatives are available to assist you between 7 a.m. and 7 p.m. (CT), Monday
through Friday, excluding holidays.

You may also send your inquiries via the Internet to CPS at:

CPS@NCS.COM

The CPS Voice Response System has phone routing set up to assist you in
designated areas. When you call 800/330-5947, you will be asked to enter the last 5
digits of your Title IV WAN User ID.

Example:

For TG50001, enter 50001

For TG60001, enter 60001

You will then be presented with a menu of options.

Choose the area appropriate to the information or assistance you need:

Menu Option Description

1 CPS Automated Customer Service Center is an automated
system through which you can check the status on batches
and applications, request faxable materials and information,
and obtain other needed data, such as reject, comment, and
assumption code definitions.

2 Application Processing – Representatives assist you with
installation and software questions.

3 Direct Loan – Representatives assist you with installation
and software processing issues.

Representatives also assist you with questions on the Direct
Loan Technical Reference.

4 Pell Payment – Representatives assist you with installation
and software questions.

5 SSCR – Representatives assist you with installation and
software questions.

6 Quality Assurance Program for Windows –
Representatives assist you with installation, software, and
program questions.

7   Packaging – Representatives assist you with installation
and software questions.

8   FISAP for Windows – Representatives assist you with
installation, software questions, and technical issues.
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When you call CPS Customer Service, you should be at your computer and prepared
to provide the following information, upon request:

• The version of EDExpress you are using (under Help/About ...).

• The type of hardware/network you are using (including total RAM, version of
Microsoft Windows, other running applications, LAN type if applicable,
available disk space, type of memory management being used, etc.).

• The exact wording of any error messages you have received, as they appeared
on your screen.

• A detailed description of the utility or function you were running when the error
occurred, what module of the software you were working in (Application
Processing, Direct Loan, Packaging, or Pell), and the steps you took to get to that
utility or function.

• A description of any resolution steps you took prior to calling.


